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1. Which tab is not available on left panel when you open a presentation? 
a. Outline b. Slides c. Notes d. All of above are available 

2. The boxes that are displayed to indicate that the text, pictures or objects are placed in it is called……….. 

a. Placeholder  b. Auto text  c. Text box  d. Word Art 
3. To start Microsoft PowerPoint application 

a. Click on Start >> Programs >> All Programs >> Microsoft PowerPoint 
b. Hit Ctrl + R then type ppoint.exe and Enter  
c. Click Start >> Run then type powerpnt then press Enter  d. All of above 

4. Which of the following section does not exist in a slide layout? 
a. Titles  b. Contents  c. Comparison  d. Animations 

5. PowerPoint presentations are widely used as 
a. note outlines for teachers   b. project presentations by students 
c. communication of planning   d. All of above 

6. _______ controls all the main slide control tasks for your presentation. 
a. Task Pane  b. Taskbar  c. Control Panel  d. None of above 

7. To insert new slide in the current Presentation, we can choose: 
a. Ctrl+N b. Ctrl+M  c. Ctrl+O d. Ctrl+F 

8. From where can we set the timing for each object? 
a. custom transition  b. Slide transition 
c. custom animation  d. slide sorter 

9. Which of the following pane is NOT available in Task Pane? (2003) 
a. Slide Design  b. Master Slide  c. Slide Layout  d. Slide Transition 

10. A new presentation can be created from 
a. Blank Presentation  b. From Existing Presentation c. From Design Template d. All of above 

 11. In slide layout panel how many layouts are available for text layout by default?  
a. 4  b. 9  c. 12  d. None of above 

 12. Which of the following statement is false? 
a. If you choose to select from one of the pre-made slide layouts, you can change the positioning 
b. If you choose to select from the pre-made slide layouts, you cannot delete the objects in the layout. 
c. Blank Slide is at the top of the ‘Content Layouts’ area in the Slide Layout panel. 
d. All of above are false statements 

13. What lets you to create new presentation by selecting ready-made font color and graphics effects? 
a. Presentation Template b. Master Slide  c. Design Template  d. Animation Scheme 

14. Which command will you use in PowerPoint if you need to change the color of different objects without 
changing content? 
a. Design Template b. Color Scheme  c. Font Color  d. Object Color 

15. What PowerPoint feature will you use to apply motion effects to different objects of a slide?  
a. Slide Transition b. Slide Design  c. Custom animation  d. Animation Scheme 

16. What feature will you use to apply motion effects in between a slide exits and another enters? 
a. Slide Transition  b. Slide Design  c. Animation Objects  d. Animation Scheme 

17. The selected design template can be applied 
a. to current slide only    b. to all the slides 
c. to all the new presentation you create  d. all of above 

18. The difference between Slide Design and Auto Content Wizard is (powerpoint 2003) 
a. Both are same   
b. AutoContent Wizard is just the wizard version of Slide Design 
c. Slide Design does not provide sample content but Auto Content Wizard provides sample content too! 
d. Slide Design asks your choice in steps but Auto Content Wizard does not let you make choices 

19.  Which option can be used to create a new slide show with the current slides but presented in a different 
order? 
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a. Rehearsal   b. Custom Slide show c. Slide Show Setup  d. Slide Show View 

20. Power Point presentation is a collection of ________ 
a. Slides and Handouts b. Speaker’s notes  c. Outlines  d. All of the above 

21. To edit an already inserted embedded organization chart object by 
a. Double Click on the organization chart object  b. CTRL + Click on the organization chart object 
c. SHIFT + Click on the organization chart object  d. None of the above 

22. Which is not the one of view options provided by PowerPoint to look at and modify presentation? 
a. Slide Show  b. Format Slide  c. Slide Sorter  d. Normal 

23. What happens if you select first and second slide and then click on New Slide button on toolbar? 
a. A new slide is inserted as first slide in presentation   
b. A new slide is inserted as second slide in presentation 
c. A new slide is inserted as third slide in presentation     
d. None of above 

24. Which of the following method can insert a new slide in current presentation? 
a. Right click on the Slide panel and choose New Slide  b. Press 'Ctrl+M' 
c. Click on New Slide button     d. All of above 

25. Which of the following is not a part of Slide Design? 
a. Design Template  b. Color Scheme  c. Animation Scheme  d. Slide Layout 

26. What is the best way to create another copy of a slide? 
a. Click the slide then press Ctrl+A and paste in new slide  
b. Click 'duplicate slide' option 
c. Redo everything on a new slide that you had done on previous slide   
d. None of above 

27. Which PowerPoint feature adds special effects to modify the appearance of the slides and the timing 
between each slide? 
a. Color Schemes b. Animation c. Transition Settings d. Handouts 

28. Which PowerPoint feature allows the user to create a simple presentation without having to spend too 
much time on it? 
a. AutoContent Wizard  b. Animation  c. Color Schemes d. Chart Wizard 

29. Which option can be used to set custom timings for slides in a presentation? 
a. Slider Timings b. Slider Timer  c. Rehearsal d. Slide Show Setup 

30. To insert slide numbers 
a. Insert a text box and select Insert >> Page Number   
b. Insert a textbox and select Insert >> Number >> PageNumber 
c. Choose Insert >> Slide Number   
d. Insert a new text box and select Insert >> slide Number 

31. In a PowerPoint presentation 
a. Sound clips can be inserted but not movie clips  
b. Movie clips can be inserted but not sound clips 
c. Both cannot be inserted     
d. Both can be inserted 

32. to insert a hyperlink in a slide 
a. Choose Insert >> Hyperlink b. Press Ctrl + K   
c. Hyperlinks can’t be inserted in slides  
d. both a & b 

33. Which option on the custom Animation task pane allows you to apply a preset or custom motion path? 
a. Add Effect  b. Emphasis  c. Animate Now   d. All of the above 

34. Which of the following statement is true 
a. You can insert text boxes in PowerPoint   
b. You cannot insert text boxes in PowerPoint 
c. Text boxes are provided when you choose a layout and can’t be inserted afterwards       
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d. None of above 
 35. When you delete a text box object from a slide in PowerPoint Presentation? 

a. The object is deleted but text box and the text inside is left on the slide 
b. The text box is deleted and the text is pasted on the slide 
c. The text box and text both are deleted  d. None of above 

36. Which of the following font effect is not available in PowerPoint Font dialog box? (2003) 
a. Underline  b. Shadow  c. Emboss  d. Strikethrough 

 37. Which of the following font effect is not available in PowerPoint Font dialog box? (2007) 
a. Underline  b. Shadow  c. Emboss  d. Strikethrough 

38. What happens if you edit an image inserted in PowerPoint 
a. The original file that was inserted is not changed  b. The original file that was inserted is changed 
c. The original file is changed when you save presentation d. None of above 

 39. The effect applied to display when slides changes in slide show view is 
a. Slide Animation  b. Custom Animation  c. Custom Transition d. Slide Transition 

40. To start slide show of a presentation 
a. Hit F5 key      b. Click Slide Show button in 'View' tab 
c. From Slide Show  choose Rehearse timing  d. both a & b 

41. Which file format can be added to a PowerPoint show? 
a. .jpg  b. .gif  c. .wav  d. All of the above 

42. In Microsoft PowerPoint, two kinds of sound effects files that can be added to the presentation are 
a. .wav files and .mid files   b. .wav files and .gif files 
c. .wav files and .jpg files   d. .jpg files and .gif files 

43. Material consisting of text and numbers is best presented as 
a. A table slide  b. A bullet slide  c. A title slide  d. All of the above 

44. What is a motion path? 
a. A type of animation entrance effect   b. A method of advancing slides 
c. A method of moving items on a slide   d. All of the above 

45. What is a slide-title master pair? 
a. The title area and text area of a specific slide        
b. a slide master and title master merged into a single slide 
c. A slide master and title master for a specific design template   
d. All of above 

46. Which of the following should you use if you want all the slides in the presentation to have the same 
‘look’? 
a. the slide layout option b. add a slide option c. outline view   d. a presentation design template 

47. in the context of animations, what is a trigger? 
a. An action button that advances to the next slide     
b. An item on the slide that performs an action when clicked 
c. The name of a motion path          d. All of above 

48. If you have a PowerPoint show you created and want to send using email to another teacher you can add 
the show to your email message as a (an) 
a. Inclusion  b. Attachment  c. Reply  d. Forward 

49. In order to edit a chart, you can 
a. Triple click the chart object   b. Click and drag the chart object 
c. Double click the chart object  d. Click the chart object 

50. To exit the PowerPoint 
a. click the application minimize button  b. click the document close button 
c. double click the applications control menu icon d. double click the document control menu icon 

51. To preview a motion path effect using the custom animation task pane, you should 
a. click the play button    b. click the show effect button 
c. double click the motion path   d. all of above 
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 52. You can create a new presentation by completing all of the following except 
a. Clicking the new button on the standard toolbar  b. Clicking file, new 
c. Clicking file open      d. Pressing ctrl + N 

 53. Which power point view works best for adding slide transitions? 
a. Slide show view b. Slide sorter view c. Slide view d. Notes view 

54. To select one hyperlink after another during a slide presentation, what do you press? 
a. Tab b. Ctrl + K  c. Ctrl + H  d. All of above 

 55. Special effects used to introduce slides in a presentation are called 
a. effects  b. custom animations  c. transitions  d. present animations 

 

56. You can edit an embedded organization chart object by 

a. Clicking edit object    
b. Double clicking the organization chart object 
c. Right clicking the chart object, then clicking edit MS-Organization Chart object   
d. b and c both 

 57. What is the term used when you press and hold the left mouse key and more the mouse around the slide? 

a. Highlighting  b. Dragging  c. Selecting  d. Moving 

58. . How can the slide show be repeated continuously? 

a. loop continuously until ‘Esc’  b. repeat continuously  c. loop more d. none 
59. How can you create a uniform appearance by adding a background image to all slides? 

a. Create a template b. Edit the slide master c. Use the AutoContent wizard d. All of the above 
60. How do you create speaker note pages that show the slides, related notes, and your company logo on each 

page? 

a. Edit the notes master and add your company logo 
b. Edit the slide master and insert your company logo and notes pane 
c. Edit the handout master to include your company logo and one slide per page with additional note space 
d. All of the above 

 61. Which option on the custom animation task pane allows you to apply a preset or custom motion path? 

a. Add effect b. Emphasis c. Animate now  d. All of the above 
 62. What is the term used when a clip art image changes the direction of faces? 

a. Group  b. Flip  c. Rotate d. All of the above 
 63. The slide that is used to introduce a topic and set the tone for the presentation is called the 

a. table slide  b. graph slide  c. bullet slide  d. title slide 
 64. Which of the following are actions you can assign to an action button or slide object? 

a. Run a macro  b. Play a sound  c. Hyperlink  d. All of above 
 65. Which option allows you to select line, curve, freeform or scribble tools? 

a. Create effect  b. Insert motion path c. Draw custom path d. All of the above 
 66. Which of the following should be used when you want to add a slide to an existing presentation? 

a. File, add a new slide  b. Insert, New slide c. File Open  d. File, New 
 67. The size of the organization chart object 

a. Is determined by the presentation design and cannot be changed 
b. Is determined by the presentation design but can be changed in PowerPoint 
c. Is dependent on the amount of text within the organization chart 
d. b and c 

 68. Which of the following is the default page setup orientation of slide in PowerPoint? 

a. Vertical  b. Landscape  c. Portrait  d. None of above 
 69. Want a PowerPoint photo album slide show to play continuously? 

a. Use random slide transitions b. Launch an online broadcast 
c. Loop continuously   d. All of the above 
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 70. What is defined by the handout master? 

a. Slide formatting      b. Layout of audience handout notes 
c. Handout content formatting for Microsoft word export d. All of above 

 71. Which of the following tool enables you to add text to a slide without using the standard placeholders? 

a. Text tool box  b. Line tool  c. Drawing tool  d. Auto shapes tool 
 72. In notes master view, how do you modify the font size of text for all the notes of a presentation? 

a. Modify the slide design    b. Modify the notes master layout 
c. Modify the text within the body placeholder d. All of the above 

 73. Want your logo in the same position on every slide, automatically? Insert it on the 

a. Handout master b. Notes master  c. Slide master  d. All of the above 
 74. Which of the following views is the best view to use when setting transition effects for all slides in a 

presentation? 

a. Slide sorter view  b. Notes pages view  c. Slide view  d. Outline view 
 75. Objects on the slide that hold text are called 

a. Placeholders  b. Object holders c. Auto layouts  d. Text holders 
 76. Which of the following provides a means of printing out feature notes with a miniature slide on a printed 

page? 

a. Slide with animation  b. Outline view  c. Notes page  d. Audience handout 
 77. Which command brings you to the first slide in your presentation? 

a. Next slide button b. Page up  c. Ctrl + Home  d. Ctrl + End 
78. In normal view, how can you quickly change to handout master view? 

a. Click the outline tab and select handout master view 
b. Press the shift key and click the handout master view button 
c. On the view menu, click slide sorter, and click handouts. 
d. All of above 

79. How can you quickly reinstate a deleted footer placeholder in master view? 

a. Create a new slide master  b. Re-apply the footer placeholder 
c. Re-apply the slide layout  d. All of the above 

 80. Which of the following can you use to add times to the slides in a presentation? 

a. Slide show menu   b. Rehearse timings button 
c. Slide transition button  d. All of the above 

 81. To select all of the boxes of an organization chart (2003) 

a. Edit > Select All            
b. Right click the chart background and then click select all 
c. Press and hold the SHIFT key and click each box       
d. All of above 

 82. You can show the shortcut menu during the slide show by 

a. Clicking the shortcut button on the formatting toolbar  b. Right clicking the current slide 
c. Clicking an icon on the current slide     d. a and b 

 83. Which arrow option is not available in the point options in slide show 

a. hidden  b. visible   c. automatic   d. manual 
 84. to edit the text within the boxes of an organization chart, you (2003) 

a. select the box and text, then make changes  b. select the box, then make the changes 
c. highlight the text, them make the changes  d. a and b both 

 85. Which of the following allow you to select more than one slide in a presentation? 

a. Alt + Click each slide   b. Shift + drag each slide 
c. Shift + Click each slide   d. Ctrl + Click each slide 

86. The view that displays the slides on a presentation as miniature representations of the slides is called 
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a. slide show  b. slide sorter view c. notes page view  d. outline view 
 87. The PowerPoint view that displays only text (title and bullets) is 

a. Slide show  b. Slide sorter view  c. Notes page view  d. Outline view 
 88. In Microsoft PowerPoint the entry effect as one slide replaces another in a show is called a (an) 

a. animation  b. slide transition  c. custom animation  d. preset animation 
 89. Which of the following presentation elements can you modify using the slide master? 

a. Slide comments b. Slide transitions c. Speaker note font and color  d. All of above 
 90. Which of the following provides a printed copy of your presentation? 

a. Outline b. Speaker notes  c. Audience handouts  d. All of the above 
91. The arrangement of elements such as Title and subtitle text, pictures, tables etc. is called 

a. Layout  b. Presentation  c. Design  d. Scheme 
 92. Presentation designs regulate the formatting and layout for the slide and are commonly called 

a. Design plates  b. Templates  c. Placeholders  d. Blueprints 
 93. Which of the following bypasses the print dialog box when printing individual slides or an entire 

presentation? 

a. File, print, preview  b. The print button  c. File, print  d. Ctrl + p 
 94. To add a header or footer to your handout, you can use 

a. The title master  b. The slide master c. The handout master  d. All of above 
 95. Which of the following will not advance the slides in a slide show view? 

a. Esc key  b. The spacebar  c. The Enter key  d. The mouse button 
 96. What are lines, curve, freeform, and scribble? 

a. Emphasis effects that can be applied to animations  b. Types of custom motion paths 
c. Predefined entrance and exit effects   d. All of the above 

97. Which of the following is not an option when printing handouts? 

a. Six slides per page b. Five slides per page c. Three slides per page  d. Two slides per page 
98. When using PowerPoint, to play a PowerPoint show for previewing the show, select 

a. View, slide sorter  b. View, slide  c. View, slide show  d. View outline 
99. In Microsoft PowerPoint in order to see all the slides on one screen use 

a. view, slide sorter  b. view, slide  c. view, master  d. view, slide show 
 100. What’s the best place to find animated images for your PowerPoint 2002 presentation? 

a. Microsoft online  b. Clipart  c. PowerPoint tools and ins d. All of the above 
 

ANSWER KEY: 
 

1 – C 2 – A 3 – C 4 – D 5 – D 6 – A 7 – B 8 – C 9 – B 10 – D 

11 – A 12 – B 13 – C 14 – B 15 – C 16 – A 17 – D 18 – C 19 – B 20 – D 

21 – A 22 – B 23 – C 24 – D 25 – D 26 – B 27 – C 28 – A 29 – C 30 – D 

31 – D 32 – D 33 – A 34 – A 35 – C 36 – D 37 – C 38 – A 39 – D 40 – D 

41 – D 42 – A 43 – A 44 – C 45 – C 46 – D 47 – B 48 – B 49 – C 50 – C 

51 – A 52 – C 53 – B 54 – A 55 – C 56 – D 57 – B 58 – A 59 – B 60 – A 

61 – A 62 – C 63 – D 64 – D 65 – C 66 – B 67 – D 68 – B 69 – C 70 – B 

71 – A 72 – C 73 – C 74 – A 75 – A 76 – D 77 – C 78 – B 79 – B 80 – B 

81 – D 82 – B 83 – D 84 – A 85 – D 86 – B 87 – D 88 – B 89 – B 90 – C 

91 – A 92 – B 93 – B 94 – C 95 – A 96 – B 97 – B 98 – C 99 – A 100 – B 
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 101. What’s the easy way to apply varied animations to text on slides (2003) 

a. apply effects in the custom animation text pane b. apply an animation scheme 
c. customize bullets with animated clipart  d. all of above 

102. Using a custom animation effect, how do you make text appear on a slide by letter 

a. Apply the animation scheme fade in one by one.  
b. Apply an entrance effect, and then set it to by letter in the effect option dialog box 
c. Apply the fly in entrance to the text, and then set its speed to very slow. 
d. All of above 

 103. To exit the PowerPoint application, you should 

a. Click the application minimize button  b. Click the document close button 
c. Double click the application control menu icon d. Double click the document control menu icon 

104.   Which of the following feature allows you to select more than one slide in slide sorter view? 

a. Alt + Click each slide   b. Shift + drag each slide 
c. Shift + Click each slide   d. Ctrl + Click each slide 

 105. You have customized a design template in one presentation and you want to use it in another 

presentation. What the best way to do this? 

a. Use the browse feature in the slide design task pane to find the file that has your design template and apply 
it to the current file. 

b. Copy and paste the slide with the design template you want to include the new presentation; inserted slide 
will inherit the design 

c. Save the presentation that has the design template with a new name, and then use a new file to your 
presentation 

d. All of the above. 
106. Which of the following options in the printer dialog box would you select to print slides 5 and 12 in a 

presentation? 

a. Slides  b. Custom shows  c. Current slide  d. All 
 107. Which of the following toolbars provides different options in various master views? 

a. Common tasks toolbar b. Drawing toolbar c. Formatting toolbar  d. Standard toolbar 
 108. You can tell when an object is active because 

a. The object is highlighted   b. Eight small sizing handles appear surrounding the text 
c. A box frame appears surrounding the text d. b and c 

  109.  One thing the common tasks button allows you to do is 

a. Apply a design template to a slide  b. Insert a new slide 
c. Choose a new layout for a slide  d. All of above 

 110. What’s the best way to design the layout for your slides? 

a. Create layouts for slides, handouts and notes using the Master Layout dialog box in slide master view 
b. For each new slide, select a layout from the Slide Layout task pane 
c. Apply templates from the Slide Design task pane 
d. None of above 

 111. Any and every command can be found on the 

a. Drawing toolbar b. Formatting toolbar c. Standard toolbar d. Menu bar 
 112.   Which key deletes text before, or the left of, the insertion point? 

a. Backspace  b. Page up  c. Delete  d. Page down 
 113. How do you print your slides in a handout that includes lines for notes? 

a. In the print dialog box, select handout and set the number of slides per page to 3 
b. In the print dialog box, select handout and set the number of slides per page, then select the include 

comment page option 
c. In the print dialog box select note page instead of handout 
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d. All of above 
114. Slide can be deleted by 

a. Selecting the slide and pressing 'delete' key  b. Right clicking the slide and selecting delete option 
c. Selecting the slide and clicking 'delete' button  d. All of the above  

115. Which of the following should be used when you want to add a slide to an existing presentation? 

a. File, add a new slide  b. Insert, new slide c. File, open d. File, new 
116. Which of the following is the default page setup orientation for notes pages, outlines and handouts? 

a. Vertical  b. Landscape  c. Portrait  d. None of above 
 117.   Which of the following is not a transition effect? 

a. Blinks diagonal  b. Dissolve  c. Fade through black  d. Blinds vertical 
118. Which is the menu to create a text box on a slide? 

a. View -> Text Box b. Tools -> Text Box c. Insert -> Text Box d. Format -> Text Box 
119. What are symbols used to identify items in a list? 

a. Icons  b. Markers c. Bullets d. Graphics 
 120. The toolbars that are displayed by default in the PowerPoint window includes (2003) 

a. Menu bar, standard toolbar, formatting toolbar, drawing toolbar 
b. Menu bar, standard toolbar, formatting toolbar, drawing toolbar, status bar 
c. Standard toolbar, formatting toolbar, drawing toolbar, status bar 
d. Menu bar, standard toolbar, status bar, drawing toolbar 

 121. Which type of template provides a design concept, fonts & color scheme for presentation? 

a. Format  b. Design  c. Content  d. Normal 
 122. You have got a bunch of digital holiday photo you want to put into a slide show. What the quickest 

method? 

a. Apply a multiple-picture layout to several slides, and use the clipart icon on the slides to import your picture 
b. On the insert menu, point to the picture, click from file, and select your picture in a group for each slide 
c. On the insert menu, point the picture and click new photo album 
d. All of the above 

123. How can you stop a slide show? 

a. Press the right arrow  b. Press Escape  c. Press the left arrow d. Press the down arrow 
 124.   To create a PowerPoint presentation from a template 

a. Click File, New, select the presentations tab and choose a template 
b. Click File, New Template and choose a template 
c. Import a presentation template from PowerPoint’s template wizard 
d. Click Create Template from scratch, Now 

125.  To save a presentation you 

a. click save on the windows start button  b. press Ctrl + F5 
c. select File, Save from the menu   d. click the saver button on the formatting toolbar 

126. You were giving your presentation, and you need to click a slide that’s few slides back. How do you get 

there? 

a. Press ESC to get back into a normal view; click the slide thumbnail in normal view; then click the resume 
slide show button 

b. Press backspace until your desired slide 
c. Right click, point to go on the shortcut menu, point to by title, and click the slide you want to go to 
d. All of above 

127. Which of the following should you do to bring a bullet back to a previous level? 

a. Press the shift + tab keys b. Press the shift key c. Press the enter key d. Press the tab key 
128. Good design determines 

a. Credibility  b. Readability  c. First impression  d. All of above 
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129. To make a selection of slides on our presentation, use a different design template from the other slides, 

what do you do? 

a. Select the slides thumbnails in that section, and apply a different color scheme 
b. Select the slide thumbnails in that section and apply a different design template 
c. Select one of the slide in the section you want to change, customize the fonts and colors, and use the format 

painter tool to apply those styles to the other slides in the section 
d. All of above 

130. your presentation is ready to go, but you don’t know if PowerPoint is installed on the computer, you will 

use to present with what’s the safe way 

a. Save your presentation as a web page  b. Set up your presentation to be ‘browse as a kiosk’ 
c. Use the Pack and Go wizard   d. All of the above 

131. Which of the following features allows you to view slides in a slide show without manually advancing 

each slide? 

a. Adding build effects b. Setting slide times  c. Adding transitions d. All of these 
132.   A file which contains readymade styles that can be used for a presentation is called 

a. Auto style  b. Template  c. Wizard  d. Pre-formatting 
 133.   To change font size of a selected slide title, you 

a. Click the toolbars font dropdown arrow and choose the font you prefer 
b. Click format, title and choose a font from the font tab 
c. Click the toolbar’s increase font size button 
d. Click title, new font, ok. 

 134.   Right clicking something in PowerPoint 

a. Deletes the object      b. Selects the object 
c. Opens a shortcut menu listing for the object  d. Nothing he right mouse button for operation 

 135.   After choosing a predefine template, ….. option has to be chosen to change a background color 

a. Design template b. Color scheme  c. Animation scheme d. Color effects 
136. Line spacing refers to 

a. The space between the lines of text  b. The height of the line 
c. The length of the line    d. a and c 

137. Which of the following uses the spelling and grammar feature to indicate an incorrect spelling? 

a. The incorrect word appears in all capital letters b. The incorrect word has a wavy red line under it 
c. The incorrect word appears italicized   d. The incorrect word appears bold 

138. Which is the Shortcut key to start a presentation from the beginning? 

a. F5  b. ALT + F5 c. CTRL + F5 d. SHIFT + F5 

139. The handout master contains placeholders for all of the following except 

a. Slide number  b. Title  c. Footer  d. Header 
140. Ellipse Motion is a predefined …. 

a. Design template b. Color scheme  c. Animation scheme d. None of these 
141.   Material consisting of text and numbers is best presented as 

a. A table slide  b.  A bullet slide  c. A title slide  d. All of above 
 142. Which of the following displays when an image is selected? 

a. Add clip art only if it relates to your topic  
b. Be sure to place at least one clipart image per slide 
c. Resize the image so it takes up as much space as your text 
d. A and b 

143.   The Microsoft clip gallery allows you to 

a. Add word art images to a slide   b. Spell check your presentation 
c. Add clip art images to a slide or slides  d. Add slides to a presentation 
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144.   Which command select all object at one time when selecting multiple objects to be deleted? 

a. Alt + A  b. Ctrl + A  c. Shift + Enter   d. Shift + A 
145. Microsoft PowerPoint is a 

a. Database program b. Spreadsheet program       c. Presentation program      d. Word processing program 
146.   What is the term used to described the separation of a clip art object into different parts so that it 

becomes a PowerPoint object? 

a. Embedding  b. Regrouping  c. Ungrouping  d. Grouping 
 147. What do you do to start the slide show? 

a. Click on Go  b. Turn on transition c. Click on the Slide Show button d. All of the above 
148. Animation schemes can be applied to ….. in the presentation 

a. All slides  b. Select slides  c. Current slide  d. All of the above 
149.   After moving a clip art image to a particular location on the slide, you can immediately reverse the 

action using the 

a. Click the not do move object command on the edit menu b. Click on the undo button 
c. Click on redo button     d. All of above 

150.   Which of the following best describes serifs? 

a. Serifs on characters help to differentiate between similar looking letters 
b. Serifs fonts are best for viewing test at a distance 
c. Serifs are fine cross strokes that appear at the bottom and top of a letter 
d. Serif font are very simple in appearance 

151.  You edit an embedded table object by 

a. Clicking the edit sub command of the document object command on the edit menu 
b. Double clicking the table object 
c. Right clicking the table object, then clicking edit document on the edit menu 
d. All of above 

 152. To print the PowerPoint presentation, press 

a. Ctrl + T b. Ctrl + E c. Ctrl + S d. Ctrl + P 
153.  you can embed a organization chart in a slide by 

a. Clicking the object command on the edit menu 
b. clicking the insert new slide button on the standard toolbar, then double clicking the organization chart auto 

layout 
c. clicking the ms organization chart button on the formatting toolbar 
d. clicking the ms organization chart button on the standard toolbar 

 154.   You can add multiple subordinates to a position by 

a. Clicking the subordinate button as you press and hold shift 
b. Clicking the subordinate button each and every time you add a subordinate 
c. Clicking the subordinate button as many times as the desired boxes 
d. All of above 

155.   What is the name of the form used to input chart values? 

a. Datasheet  b. Microsoft Excel c. Microsoft graph d. Auto form 
 156.   Which of the following you must first complete in order to delete an object? 

a. Double click the image b. Select the image  
c. Resize the image  d. Move the image to a new location 

 158.   The auto shapes tool provides you with 

a. Fancy text to place on your slide  b. Commonly found shapes 
c. Any shape you want to add on a slide  d. Clip art that is related to your presentation 

 159. Which of the following should e used when you want to add a slide to an existing presentation? 

a. File, add a new slide  b. Insert, new slide  c. File, open  d. File, new 
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 160.   An organization has a president, vice president, managers and supervisors. On what level of an 

organization chart are the vice presidents 

a. Fourth level  b. Third level  c. Second level  d. First level 
 161.   Which of the following includes special effects that can be applied to drawing objects? 

a. Gradient fills  b. Line color and style  c. Rotating  d. All of above 
 162.   What is the term used when a clip art image changes the direction it faces? 

a. Group b. Flip  c. Rotate d. a and b 
 163.   What is the term used when you press and hold the left mouse key and move the mouse around the 

slide? 

a. Highlighting  b. Dragging  c. Selecting  d. b and c 
 164.   The size of a table object 

a. Is dependent on the amount of text within the table 
b. Is determined by the presentation design but can be changed 
c. Is determined by the presentation design and cannot be changed 
d. a and c 

 165.   The size of an organization chart object 

a. Is determined by the presentation design and cannot be changed 
b. Is determined by the presentation design but can be changed in PowerPoint 
c. Is dependent on the amount of text within the organization chart 
d. B and c 

 166.   Which of the following statements is not true? 

A. You can type text directly into a PowerPoint slide but typing in text box is more convenient.  
B. From Insert menu choose Picture and then File to insert your images into slides.  
C. You can view a PowerPoint presentation in Normal, Slide Sorter or Slide Show view.  
D. You can show or hide task pane from View >> Toolbars. 

 167.   To maintain the perspective (height and width ratio) of an object when resizing, you need to 

a. Press and hold the shift key while dragging a corner sizing handle 
b. Press and hold the alt + ctrl keys while dragging a middle handle 
c. Drag a corner sizing handle 
d. A and c 

 168.   Which of the following is/are true about rulers and guides? 

a. Rulers and guides can be turned on or off 
b. Rulers and guides print on the slide 
c. Rulers and guides help place objects on the slide 
d. A and c 

 169.   To edit the text within the boxes of an organization chart, you 

a. Select the box and text, then make the changes 
b. Select the box, then make the changes 
c. Highlight the text, then make the changes 
d. Highlight the text then make the change 

 170.   What is the name of the form used to input chart values? 

a. Datasheet  b. Microsoft Excel  c. Microsoft graph  d. Auto form 
 171.   Which of the following options changes the fill color of an object back to the default color? 

a. Template  b. Automatic  c. Patterns  d. Fill colors 
172.   Which of the following should you use to add shading to a drawing object on or an auto shape object? 

a. Text box tool  b. Line tool c. Fill color  d. B and c 
 173.   Which of the following tools enable you to add text to a slide without using the standard placeholders? 

a. Text box tool  b. Line tool c. Fill color d. Auto shapes tool 
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 174. To access Picture, Test Box, Chart etc. which menu you have to select ? 

a. Insert  b. View   c. File   c. Edit  
175.   Which of the following must be used with the mouse when you want to resize an image from the center 

and keep it proportioned? 

a. The space bar b. The alt key  c. The ctrl key  d. The shift key 
 176.   Which of the following should be used with the mouse when you want to draw a perfect shape? 

a. The spacebar  b. The alt key  c. The ctrl key  d. The shift key 
 177.  What will happen if you release the mouse button before releasing the shift key when you draw a 

square? 

a. The square will not be a perfect square b. The square will not be at the center of the slide 
c. The square will be smaller   d. The square will be larger 

 178.   On which part of the chart are the values entered in a data sheet displayed? 

a. The title area  b. The legend c. The y-axis  d. The x-axis 

 179.   in order to edit a chart, you can 

a. triple click the chart object  b. click and drag the chart object 
c. double click the chart object  d. click the chart objects 

 180.   When an image is selected, it displays which of the following? 

a. Two corner handles  b. Six middle handles  c. Eight sizing handles d. Six boxes 
 181. To draw the Square box in the slide by selecting rectangle tool 

a. Holding CTRL & Draw b. Holding ALT & Draw c. Holding SHIFT & Draw  d. All of the above 

182. To place something in the same position on every slide of presentation automatically, insert into 

a. Slide master b. Notes master  c. Handout master d. None of the above 

 183.   Press animation effects allows you to 

a. Add clip art images to your slides  b. Create a custom transition to the next slide 
c. Show bullet items as they are discussed d. None of above 

 184. Holding down the Shift key and rotate the image will rotate in increments of 

a. 10 degrees  b. 15 degrees  c. 20 degrees  d. 25 degrees 
185. Which of the following is an example for Automatic Text formatting? 

a. Underlining Hyperlink  b. Adjusting extra space 
c. Replacing two – s with a hyphen d. All of the above 

 

 

ANSWER KEY: 

 

01 – B 102 – B 103 – C 104 – D 105 – A 106 – A 107 – A 108 – A 109 – D 110 – B 

111 – D 112 – A 113 – A 114 – D 115 – B 116 – C 117 – A 118 – C 119 – C 120 – B 

121 – B 122 – C 123 – B 124 – A 125 – C 126 – C 127 – A 128 – D 129 – B 130 – C 

131 – B 132 – B 133 – C 134 – C 135 – B 136 – A 137 – B 138 – A 139 – B 140 – C 

141 – A 142 – D 143 – C 144 – B 145 – C 146 – C 147 – C 148 – D 149 – B 150 – C 

151 – D 152 – D 153 – B 154 – D 155 – A 156 – B 157 – C 158 – B 159 – B 160 – C 

161 – D 162 – D 163 – D 164 – B 165 – D 166 – A 167 – A 168 – D 169 – A 170 – A 

171 – B 172 – D 173 – A 174 – A 175 – C 176 – D 177 – A 178 – C 179 – C 180 – C 

181 – C 182 – A 183 – C 184 – B 185 – D      

 


